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Please Note:  All Meetings will now be  on the second  
Tuesday of each month.  Starting at 3:00 P.M.  
Location:  Christ Lutheran Church 

481 Snead Drive, Fairfield Glade TN 

June  10th Program  
@ 3:00 P.M. 

 
 

This month’s program will be  
directed by our President George 
Senstock. 
 
We will have our 4th annual  
discussion on streaming.   
 
This time we will focus on weed-
ing through the confusing options 
and methods to organize your 
subscriptions and episodes 
watched.  
 

Saturday, June 14, 2025 
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Join the Club! 
Anyone interested to attend the general meeting or any of 
the SIG meetings as a guest will be charged $3.00 per per-
son for any or all meetings in that month. Afterwards, you 
are encouraged to become a member of the Plateau PC 
Users Group.  Our Club cannot exist without you, the 
members.  
  

Membership Dues  
Our annual dues are now payable July 1st. of each year.  
Annual  dues are $24 per single person / $30 per family.  
Persons/families joining during the fiscal year have dues 
payable as follows: 
 

 
 

 
BOARD OF DIRECTORS DISCLAIMER 

All members of the Plateau PC Users Group are willing 
to help one another in the area of advice and tutorial in-
struction over the phone.  If you should require more in-
volved services or instruction, we have a few members 
who are very knowledgeable in several areas.  As a re-
sponsible  
consumer, it is up to you to discuss, before retaining a 
member, any and ALL charges for repair services and 
time consuming tutorial activities. 
 
It is not the desire of this Board of Directors to set fees 
for individuals for services rendered, nor the responsibil-
ity to intervene between members who enter into a con-
tract among themselves. 
 
The GAZETTE is published using the following:  Mi-
crosoft Word, Microsoft Publisher, and Microsoft Win-
dows.  The Gazette is the monthly newsletter of the Plat-
eau PC Users Group, Inc. 
 
DISCLAIMER:  No warranty, express or implied, is 
made by the PPCUG, the Gazette editorial staff or its 
contributing editors.  This extends to all losses incidental 
or consequential from the use or non-use of any infor-
mation in any issue of the Gazette. 
 
All images used in the newsletter, website, blogs, class 
materials or handouts (“media”)  are obtained from a “free 
use” source, preferably images that have been released as 
“CCO Public Domain”. 

 
 
 

 

PPCUG, Inc. 2025-2026 Board Members 

 Join In 
July - 
Sept 

Oct - 
Dec 

Jan - 
Mar 

Apr - 
June 

Single $24 $18 $12 $6 

Family $30 $22 $15 $7 

President George Sengstock (224) 760-3948 

Vice-President/  Charlie Merrick (931) 210-8013  

Treasurer Richard Del Frate (931) 456-2251 

Secretary Richard Del Frate (931) 456-2251 

Membership George Sengstock (224) 760-3948 

Publicity George Sengstock (224) 760-3948 

Gazette Editor Gordon Botting (931) 456-2184 

APCUG Rep  George Sengstock (224) 760-3948 

Equipment  
Custodian 

 Bob Willis (931) 456-6511 

Webmaster Alan Baker  (931) 239-0877 

Directors at Large 

Alan Baker Gordon Botting Jim Buxton   

Barbara Duncan 
 
Bob Willis 

Richard Del Frate 
 
 

Randy Knowles 

Printed by, Business Equipment Clinic 
539 West Ave. Suite 101  Crossville TN 38557 
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** Visit the PPCUG Website ** 
At: www.PPCUGinc.com.Read all about our club activities and scheduled monthly meetings, also current and past  
issues of the  Gazette Newsletter. Links also to the Meeting Handouts on past presentations. 
Send your comments and suggestions to the PPCUG Webmaster,  
Alan Baker @ jackal33980@gmail.com  (931) 239-0877 

Windows Update May 2025 Issues 

Microsoft released security updates for Windows on May 2025 Patch Day, which included a cumulative up-
date for Windows 10 Version 22H2 and Windows 10 Version 21H2 (KB5058379).3 Some users have re-
ported issues with the update, including prompts that suggest the system is "starting over" or encoun-
tering errors during the installation process.3 If you are experiencing such issues, you can try the follow-
ing steps: 

1. Check for Updates Manually: 

o Open the Start menu, type "Windows Update," and select the result. 

o Click the "Check for updates" button to manually check for updates. 

o If the update is not downloaded automatically, click the "Download & install all" but-
ton. 

2. Download and Install Manually: 

o Visit the Microsoft Update Catalog to download the update manually. 

o Install the update from the downloaded file. 

3. Troubleshoot Windows Update: 

o Run the Windows Update troubleshooter to identify and fix issues. 

o If the troubleshooter opens the Microsoft Store and offers to download a helping app, 
you can try other troubleshooting methods. 

4. Postpone Updates: 

o If the update continues to cause issues, you can postpone it for a few weeks and ex-
tend the postponement if necessary. 

If these steps do not resolve the issue, you may need to seek further assistance from Microsoft Support. 
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Microsoft Word: How to Stop Annoying Automation in Word 

Microsoft Word Tips & Tricks 

 

Does Microsoft Word automatically number a list of items even when you want a different look or format 
to a numbered list? How do you stop Word from automatically changing the text you enter into a docu-
ment? Although the standard options in Word are designed to help make it easier to enter and format docu-
ment text, some options can actually get in the way of creating documents. Find out how to get back con-
trol of your documents by making a few easy changes to the options in Microsoft Word to stop annoying 
automation in this article or watch this video: 

Why Text Automatically Changes in Word 

Does it seem like Word randomly changes the capitalization or spelling of text in a docu-
ment? AutoCorrect is to blame. As the name indicates, AutoCorrect automatically corrects the spelling of 
commonly misspelled words but also makes other changes, including capitalizing the first letter in a sen-
tence, table cell, or line of text. To review your choices and stop annoying automation in Word: 

1. Pick File > Options. 

2. Select AutoCorrect Options from the Proofing category. 

3. Choose the AutoCorrect tab (Word 365 screen shown) and uncheck any option that gets in the 
way of adding your text. 

 

How to Stop Automatic Outlines & Numbered Lists You Don’t Want 

Have you ever tried to create your own numbered list or outline with letters and then watched the number-
ing or formatting change once you press [Enter] for the next line? This is a huge annoyance if you want to  

(Continued on page 5) 
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build your own custom layout for an outline rather than working with the choices in Word. 

Do you type your email address or website into a document and then watch as it suddenly changes to blue 
underlined text (a hyperlink)? Do you ever enter fractions or quotes that automatically re-format? 

You are a victim of AutoFormat As You Type, a common Word ailment. Although some of these op-
tions can be helpful, turn them off if they get in the way of your work. To customize Word so that it 
works for you and not against you: 

1. Choose File > Options. 

2. Pick AutoCorrect Options from the Proofing category. 

3. Choose the AutoFormat As You Type tab (Word 365 screen shown) and uncheck any option 
that gets in the way of typing your text. Choices include smart quotes (different open and close 
quotes), fractions, hyperlinks to websites and email addresses, and automatic numbering. 

 

I recommend you uncheck all of the options in the last two sections, including Automatic numbered 
lists. You can still turn on the automatically numbered list any time you want them. If you work with a lot 
of multi-level outlines and lists, you’ll want to keep the choice to Set left- and first-indent with tabs 
and backspaces found in the bottom section. Turn off choices in the 1st section as desired. Pick OK to 
finish. 

Automatic numbered and bulleted lists and outlines can still be created from the Home tab (Paragraph 
group) in the Ribbon. Other formatting choices such as hyperlinks or special symbols can still be added to 
Word documents as needed 

(Continued from page 4) 
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Microsoft Office: The Disappearing Ribbon 

Microsoft Office Tips & Tricks 

What does your Ribbon look like? Can you see all of the icons and options, or are they hidden? One of the 
common questions I hear from participants in my speaking and training sessions for Microsoft Office  

programs is why their Ribbon looks different than mine because their Ribbon has “disappeared.” 

Although the Microsoft Office Ribbon is command central for your Office programs, the Ribbon can be 
minimized when you want more vertical screen space to focus on your work. To learn more, follow the 
steps below in this article or video. 

How to Hide or Display the Microsoft Office Ribbon 

 

To collapse or restore the Ribbon, try these options: 

· Right-click the Ribbon or Quick Access toolbar and select Collapse the Ribbon from the shortcut 
menu. Repeat again and uncheck the option to restore the Ribbon. 

· Double-click on the active tab to collapse. Double-click on any tab to re-display the full Ribbon. 

· Minimize the Ribbon using the [Ctrl] + [F1] toggle, which leaves only the tabs. 
Press [Ctrl] + [F1] again to restore the Ribbon. 

· Click once on the Ribbon Display Options button in the upper-right corner of the program win-
dow (next to the Windows management buttons). Choose from options to Auto-hide Rib-
bon, Show Tabs, Show Tabs and Commands. The look of this button varies with each version of 

 

 Microsoft Office.  

(Continued on page 7) 
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Unless you use it frequently, the Auto-hide Ribbon option might be too extreme as it can be easy to for-
get you enabled this feature on purpose. If you choose Show Tabs or any of the other choices listed 
above, you’ll free up more vertical space yet still see the tab names. 

 

 
 

When you want to work with a command while the Ribbon is minimized, simply click a tab containing a 
tool you want to use, and the Ribbon will display until you make your choice. Then, it will disappear 
again as you continue to work. Whether you use a keyboard shortcut or a mouse action, it’s easy to cus-
tomize how you want to display the Microsoft Office Ribbon. And no more disappearing Ribbon … at 
least not by accident! 

 
 
 

Difference between Linux and Windows 

·  

Linux: Linux could be a free and open supply OS supported operating system standards. It provides pro-
gramming interface still as programme compatible with operating system primarily based systems and 
provides giant selection applications. A UNIX operating system  additionally contains several severally 
developed parts, leading to UNIX operating system that is totally compatible and free from proprietary 
code. 
 
Windows: Windows may be a commissioned OS within which ASCII text file is inaccessible. it’s de-
signed for the people with the angle of getting no programming information and for business and alterna-
tive industrial users. it’s terribly straightforward and simple to use. The distinction between Linux and 
Windows package is that Linux is completely freed from price whereas windows is marketable package 
and is expensive. Associate operating system could be a program meant to regulate the pc or computer 
hardware Associate behave as an treater between user and hardware. Linux is a open supply package 
wherever users will access the ASCII text file and might improve the code victimisation the system. On 
the opposite hand, in windows, users can’t access ASCII text file, and it’s a authorized OS. Let’s see that 
the difference between Linux and windows: 
 
Linux Vs. Windows 
 
Here is a detailed comparison between Linux and Windows: 

(Continued from page 6) 

(Continued on page 8) 
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Linux 
Linux is a free and open-source operating system built on UNIX standards. It provides a programming inter-
face still as program compatible with operating system primarily based systems and provides giant selection 

S. No Linux Windows 

1. Linux is an open-source operating 
system. 

Windows is not an open-source operating system. 

2. Linux is free of cost. Windows is paid and requires a license. 

3. File names are case-sensitive, 
meaning file.txt and File.txt are 

different. 

File names are case-insensitive, meaning file.txt and File.txt are treated the same.

4. Uses a monolithic kernel. Uses a hybrid kernel. 

5. More efficient and stable, espe-
cially for servers and developers. 

Less efficient due to resource-intensive processes. 

6. 
Uses forward slash (/) for directo-

ry separation. 
Uses backslash (\) for directory separation. 

7. More secure with better user con-
trol and fewer vulnerabilities. 

Less secure due to higher susceptibility to malware and viruses. 

8. 
Preferred by hackers and security 
experts due to its open-source na-

ture and control. 
Not widely used for hacking as it lacks built-in security tools. 

9. Has 3 types of user accounts: (1) 
Regular, (2) Root, (3) Service Ac-

count. 

Has 4 types of user accounts: (1) Administrator, (2) Standard, (3) Child, (4) Guest.

10. 
Root user has all administra-

tive privileges. 
Administrator user has all administrative privileges. 

11. In Linux, you can have two 
files with the same name but 

different cases 
(File.txt and file.txt). 

In Windows, you cannot have two files with the same name in the same folder.
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applications and it is highly customizable and widely used in servers, develop-
ment environments, cybersecurity, and embedded systems. 
A UNIX operating system additionally contains several developed parts, leading to a UNIX operating 
system that is totally compatible and free from proprietary code. Linux allows users to access, modify, 
and distribute its source code, making it a preferred choice for developers, system administrators, and 
ethical hackers. 
 
Key Features of Linux: 

· Open-Source Nature: Unlike Windows, Linux distributions (distros) such 
as Ubuntu, Debian, Fedora, and Arch Linux offer full access to the source code, allowing 
users to modify and optimize their system. 

· Security & Stability: Linux is known for its robust security, providing built-in us-
er privilege control, fewer vulnerabilities, and better protection 
against malware and viruses compared to Windows. 

· Lightweight & Efficient: Many Linux distributions, including Arch Linux and Linux 
Mint, are lightweight and optimized for performance, making them faster than Windows, es-
pecially on older hardware. 

· Diverse Software Support: The Linux ecosystem supports a vast range of applications, from 
open-source alternatives to proprietary software. Users can install programs using package 
managers like Pacman (Arch Linux), APT (Debian/Ubuntu), and DNF (Fedora). 

· Linux vs. Windows for Developers: Linux provides powerful tools, including terminal-based 
programming, shell scripting, and support for multiple programming languages, making it ide-
al for developers, DevOps engineers, and data scientists. 

· Linux Rolling Release Model: Distros like Arch Linux follow a rolling release model, en-
suring users always have the latest updates without needing to install a new version. 

·  
Where is Linux Used? 

· Servers & Cloud Computing: Linux dominates web servers, with distributions like Cen-
tOS, Ubuntu Server, and Debian powering most of the internet and enterprise cloud infra-
structure. 

· Cybersecurity & Ethical Hacking: Tools like Kali Linux and Parrot OS make Linux the top 
choice for penetration testing, network security, and ethical hacking. 

· Gaming on Linux: With improvements like Steam Proton, Lutris, and Wine, gam-
ing on Linux has significantly improved, allowing users to play Windows-based games with 
better compatibility. 

Windows 
Windows is a proprietary operating system developed by Microsoft, designed for ease of use, software 
compatibility, and business applications. Unlike Linux, which is an open-source operating system, Win-
dows restricts access to its source code, making it a closed-source OS where modifications are not per-
mitted by users. 
Windows is widely used for personal computing, gaming, enterprise solutions, and office environments, 
primarily due to its intuitive Graphical User Interface (GUI), plug-and-play functionality, and exten-
sive software ecosystem. It is ideal for users with no programming knowledge, offering a simple point-
and-click interface for effortless navigation. 
One of the major differences between Linux and Windows is that Linux is free and open-source, where-
as Windows requires a paid license for installation and use. Different editions, such as Windows 10 

(Continued from page 8) 

(Continued on page 10) 
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Home, Pro, and Enterprise, cater to various user needs, but they all require a product key or subscrip-
tion model (Windows 365) for activation. 

 

Key Features of Windows 

· Graphical User Interface (GUI): A visually appealing and easy-to-use environment with 
Start Menu, Taskbar, and File Explorer. 

· Software Compatibility: Supports Microsoft Office, Adobe Suite, and a vast range of third-
party applications that are not available on Linux. 

· Gaming Performance: Offers DirectX, high-end GPU driver support (NVIDIA, AMD), and 
compatibility with AAA games, making it the preferred choice for gamers. 

· Hardware Support: Works seamlessly with a wide range of printers, scanners, and USB pe-
ripherals without needing additional drivers. 

· Regular Updates: Receives security patches and feature updates through Windows Update, 
but major version upgrades require reinstallation (e.g., Windows 10 to Windows 11). 

Note: While Windows excels in user-friendliness and software availability, it lacks the flexibility, security, 
and customization found in Linux distributions. Since it is a closed-source operating system, users cannot 
modify the source code, limiting customization compared to Linux-based systems like Ubuntu, Arch 
Linux, and Fedora 

Linux or Windows which one is Better for You? 

Choosing between Linux and Windows depends entirely on your needs, technical expertise, and usage 
preferences. Both operating systems excel in different areas, catering to different types of users. Below is 
a breakdown to help you decide which OS suits you best. 

 

Choose Linux If: 

· You value security and privacy – Linux is inherently more secure, with fewer vulnerabilities 
and better access control. 

· You want a free and open-source OS – No licensing fees, full access to source code, and 
freedom to modify as needed. 

· You prefer customization and control – With distros like Ubuntu, Arch Linux, and Fedora, 
you can fine-tune everything. 

· You are a developer or system administrator – Linux provides powerful command-line 
tools, scripting capabilities, and server optimizations. 

· You work in cybersecurity or ethical hacking – Kali Linux and Parrot OS are widely used 
for penetration testing. 

· You need a lightweight OS for old hardware – Linux runs efficiently on low-end machines 
with minimal resource usage. 

(Continued from page 9) 

(Continued on page 11) 
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· You want a rolling release model – Arch Linux and other distros provide continuous up-
dates without major version upgrades. 

Choose Windows If: 

· You want an easy-to-use OS with plug-and-play functionality – Windows is designed for 
non-technical users. 

· You need proprietary software like Microsoft Office or Adobe Photoshop – These appli-
cations are natively supported on Windows. 

· You are a gamer – Windows has better gaming support with DirectX, NVIDIA/AMD driv-
ers, and compatibility with all major games. 

· You require seamless hardware compatibility – Windows supports printers, USB devices, 
and peripherals without extra setup. 

· You prefer official customer support – Microsoft provides dedicated support for Windows 
users, unlike Linux, which relies on community forums. 

· You are a business user or working in a corporate environment – Most businesses rely 
on Windows-based applications for daily operations. 

We will have our 4th annual discussion on streaming.  This time we will focus on weeding through 
the confusing options and methods to organize your subscriptions and episodes watched.  
 
 
 

Shortcuts 
 

By Mike Moore, 
 Editor, Bowling Green Area Microcomputer User Group, Kentucky 
www.bgamug.org 
ml.moore@insightbb.com 
 

Obtained from APCUG with the author's permission for publication by APCUG member groups. 

Why do some icons on your desktop have a little white arrow embedded in the picture? 

These are shortcuts (sometimes called links). They are small files that represent and “point to” the real 
thing. When you double -left-click on a shortcut icon, Windows reads the location of the file to open 
from within the shortcut file, then opens the target file. Shortcuts are, in the lingo of computer program-
mers, symbolic links to actual files. They don’t contain any of the file’s information—they just point to 
it. In real terms: if Peoria, Illinois was a file, then its shortcut would be the map telling you how to get 
there. 

 

(Continued from page 10) 
 

(Continued on page 12) 
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Why do we use shortcuts? Why not just put the real, actual file on your desktop? There are several rea-
sons. First, since a shortcut does not contain any of the target file’s information, it can be deleted without 
damaging the file it points to. Therefore, placing 

shortcuts on the desktop (or in any directory) is safer. Accidental deletion of these links will not affect 
anything other than you may lose track of where your file was! 

The other reason is that you can have many shortcuts and place them anywhere you might need quick ac-
cess to your file. For example, when we give away computers, we organize the software links in various 
folders on the desktop. There’s a folder for 

Educational software and Game software links, and for the software that is both Educational and Fun, we 
put links to the same program in both the Educational and Game folders. You can rename shortcuts to 
anything you want, and it won’t affect the real name of the file they point to. 

Shortcuts are also portable! If I know for sure that a program will be in a certain place on nearly every 
PC, I can e-mail a link to someone and tell them to place it on their desktop. Double-clicking on it should 
open that file on my recipient’s PC! E-mailing 

a link is much more of a sure bet than e-mailing an executable file—because most e-mail servers just 
won’t allow executables (files ending in .EXE) to be sent! 

How does one create a link? The best way is to find the file you want the link to refer to, then do a single 
right-click on it. This brings up a context menu where you can create the shortcut. Once the shortcut is 
created you can move it to any directory or to the desktop. 

For creating desktop links, Windows provides a shortcut wizard that allows you to create a shortcut for 
any file type including a web page or another folder. From anywhere on the desktop, right click and select 
‘New’ and then ‘Shortcut’ to activate this wizard.  

 

(Continued from page 11) 
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Vote for PPCUG Officers Election on June 10, 2025 
  

 Suggested candidates slated for PPCUG Board include: 
  

(For the period July 2025 through June 2026) 
 
President:        George Sengstock 
Vice President:  Charlie Merrick 
Treasurer:         Richard Del Frate 
Secretary:*         Richard Del Frate 
  
Write In:   *Susan Wright McKay 
 
Directors at Large:  
  Alan Baker 
  Gordon Botting   
 Jim Buxton 
 Barbara Duncan 
  Richard Del Frate 
  Randy Knowles 
  Bob Willis  
   

Important Message 
  

PPCUG Board Election 2025/2026 
  

The above names are the current slated names for the upcoming election in 
this this year’s June General Meeting. 
  
We are asking (or pleading) with the membership for more nominations to 
join as additional board members or even replace any of the above names. 
  
Please do your bit to help keep our computer club operating into the future. 
  
This will be your chance to have your word heard at the General Meeting on 
Tuesday, June 10, 2025 
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How to Create Easy PDF Documents in Microsoft Office 

Microsoft Office Tips & Tricks 

 

Did you know that you can create a PDF document in Microsoft Office without Adobe Acrobat? Convert-
ing a file to a PDF helps preserve formatting, fonts, and layout and makes it more difficult to change the 
document.  

Although Acrobat offers many additional features, the built-in PDF option in Microsoft Office may be all 
you need if you’d like to quickly create a PDF document from Microsoft Word, Excel, or PowerPoint.  

(This option is available in all recent versions of Microsoft Office, including Office 365, Office 2021,  

Office 2019, and Office 2016.) 

To create a PDF from Microsoft Office: 

1. Open an existing Word document, Excel workbook, or PowerPoint presentation. 

2. Choose the File menu and pick Export. 

3. From this option, click Create PDF/XPS Document, and then from the right pane, click 
the Create PDF/XPS button. 

4. Enter an appropriate name and location and click Publish to convert the document into PDF for-
mat. 

That’s it! Try these easy steps to create your next PDF file. 

Although you may not need Adobe Acrobat for simple documents, when do you need Acrobat or similar 
programs? 

· Creating fillable forms 

· Controlling document security 

· Applying redaction features 

· Working with commenting and reviewing features 

· Creating and managing a PDF from multiple sources 

· Applying and reviewing document accessibility (Section 508-compliance) 
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Revised April 2025 

 
Plateau PC Users Group, Inc.  

 

 Application for Membership for 2025-2026 
   
            ------- New Member    ------ Renewing Member 
 
Return this application with a check for annual dues payable to “PLATEAU PC USERS GROUP”  
Return to the club Treasurer during our meeting or mail to  
“PPCUG Treasurer. 221 Tomlon Road, Crossville TN  38555” 
 
Our annual dues are now payable July 1st. of each fiscal year.  
  
Persons// families joining during the fiscal year have dues payable as follows: 
 

 
 
Date: --------------------               Amount Paid: $ --------------------   by Cash ------ , or Check (# ----------------------- ) 
 
 
--------------------------          -------------------------      -------------------------------------------- 
Last Name   First Name  Family Member (if family membership) 
 
------------------------------------------------------------------------------- 
Address: 
 
--------------------------------------        --------           ---------------    (-------------) ----------------------------- 
City     State  Zip Code Phone Number 
 
E-Mail address: ---------------------------------------------------------------------- 
    Please Print 
 
I have belonged to a Computer Club before:  Yes -----------     No ------------  
 
I have used PC’s since (year): ------------------  
 
I have knowledge in the following areas that I would be willing to share with club members: 
 

 
 

 
 

 
 

 Join In July - Sept Oct - Dec Jan - Mar Apr - June 

Single $24 $18 $12 $6 

Family $30 $22 $15 $7 



 
Gazette June 2025                             www.PPCUGinc.com                                                  Page  16  

July 2025 

Sun Mon Tue Wed Thu Fri Sat 

  1 2 10:00 A.M. 

PPCUG Board 
Meeting 

3 4 5 

6 7 8 3:00 P.M. 
General Mtg. 
Presentation.  
Followed by 
Q&A Session 
  

9 10 11 12 

13 14 15 16 17 18 19 

20 21 22 23 24 25 26 

27 28 29 30 31   


